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Changes from the last release 
This version of the handbook references the production version of FastBallast and FaBtest version 3.x.  
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Introductory section 
1.1 Scope 

This handbook 
references the 
production 
version of the 
FastBallast 
Compliance 
Monitor, as 
shown right. It is 
important that 
the included 
Panasonic 
Toughpad is 
stored with the 
screen facing 
into the lid (as 
shown) when 
the lid of the 
FastBallast unit is 
closed. This 
provides 
maximum 
protection for 
the Toughpad 
screen. 

The production 
version of 
FastBallast can 
only be used 
with FaBtest 
V3.x. 
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1.2 Parts list check 

The FastBallast system delivery pack should include the following: 

• Backpack (113920) 

• The main compartment of the backpack should contain: 
o FastBallast unit (2355-130-PL-A) containing: 

▪ FastBallast stir unit (2355-138-PL-A) 
▪ Panasonic ToughPad with FaBtest installed (2355-149-PL-A) 

o FastBallast charger with 15 V at 1.2 A output (2355-137-PL-A) 
o FastBallast to USB cable  (2355-085-PL-A) 
o 40 x 20 mL sample cups (119125) 
o 2 x 350 mL empty bottles for tap water (120021) 
o 6 x 3 mL Pasteur pipettes (925791264) 
o 12 x 1 mL Pasteur pipettes (925791271) 
o 2 x 30 mL syringes (120020) 

• The inner front panel of the backpack should contain: 
o USB key containing electronic documentation and FaBtest installation (2355-

151-PL-A) 
o Small parts for the Panasonic ToughPad (2355-149-PL-A) 
o 6 x spare screws for the stir unit (113951) 

• The outer front panel of the backpack should contain the following Panasonic 
ToughPad parts: 

o Operating instructions (2355-149-PL-A) 
o Soft cloth (2355-149-PL-A) 
o Grab handle (2355-149-PL-A) 
o Stylus (2355-149-PL-A) 

• The following parts should be included within the shipping case, but outside the 
backpack: 

o FastBallast Ethernet cable (2355-086-PL-A) 
o FastBallast charger UK power mains lead (111002) 
o FastBallast charger EU power mains lead (111003) 
o FastBallast charger US power mains lead (111004) 
o Panasonic ToughPad UK power mains lead (2355-149-PL-A) 
o Panasonic ToughPad EU power mains lead (113948) 
o Panasonic ToughPad US power mains lead (113949) 
o Quick start guide (2355-001-HB) 
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Inner compartment of the backpack (Pasteur pipettes and 30 mL syringes not shown) 

 

 

Inner and outer pockets of the backpack 

  



   

 
 2355-001-HB Issue G  Page 7 of 47 

1.3 Targeted test requirements 

It has long been accepted that ballast water functions as a vector for the transfer of harmful species. In an attempt to 

prevent such transfer, the U.S. Coast Guard Ballast Water Discharge Standards (USCG BWDS) are currently being 

implemented and will be applied to all ships visiting U.S. waters by December 1st, 2016. These standards (summarized 

in Table 1) are largely consistent with the 'International Convention for the Control and Management of Ships’ Ballast 

Water and Sediments' (IMO, 2004). This convention has now been ratified and will be enforced on September 8th 

2017. 

Division of the USCG BWDS 

Limit  

(SI units) 

Limit  

(BWDS units) 

1 Living cells greater than or equal to 50 µm in the 
minimum dimension 

< 10 cells m-3 < 10 cells mL-1 

2 Living cells greater than or equal to 10 µm and less than 
50 µm in the minimum dimension 

< 1 x 107 cells m-3 < 10 cells mL-1 

3i Toxicogenic Vibrio cholerae (O1 and O139) < 1 x 104 cfu m-3 < 1 cfu 100 mL-1 

3ii Escherichia coli < 2.5 x 106 cfu m-3 < 250 cfu 100 mL-1 

3iii Enterococci < 1 x 106 cfu m-3 < 100 cfu 100 mL-1 

Table 1.1: Summary of the U.S. Coast Guard Ballast Water Discharge Standards (2012).  

Although zooplankton and phytoplankton are both represented within Division 1 and Division 2, it is generally the 

case that zooplankton dominate the former while phytoplankton dominate the latter. FastBallast specifically targets 

Division 2 of the USCG BWDS by interrogating chlorophyll fluorescence emission from photosynthetically active 

phytoplankton. Throughout this document, the PASS/FAIL threshold for a FastBallast test should be taken to mean 10 

phytoplankton cells between 10 µm and 50 µm in the smallest dimension. 

1.4 The FastBallast system 

1.4.1 Summary of advantages 

• Provides rapid, on board compliance testing 

• Detection limit of < 1 cell/mL 

• Does not depend on an assumed level of fluorescence per cell 

• Sampling issues associated with analyzing small static volumes at close to the D2 threshold are overcome by 
using a larger stirred volume of 20 mL 

• Very low level of false negatives and negligible possibility of false positives 

• Wide dynamic range provides a high tolerance of background fluorescence (from dead cells, CDOM and 
other sources) 

• High level of turbidity rejection 

• Minimal consumables and no sample preparation required 

• Long service intervals (two years) 

1.4.2 In more detail 

FastBallast is an ultra-sensitive active chlorophyll fluorometer system designed to allow for rapid assessment of the 

density of living phytoplankton cells within ballast water discharge. It is a highly portable device, providing 8 h 

operation on a single battery charge. Its uncompromising design provides the resolving power and dynamic range to 

detect fluorescence from living phytoplankton cells at well below the density allowed within Division 2 of the USCG 

BWDS standards, even in the presence of a high level of fluorescence from other sources. 
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The FastBallast system incorporates four LED arrays to excite chlorophyll and other light harvesting pigments within 

phytoplankton cells. The emission wavebands for these LEDs are centred at 455, 470, 530 and 624 nm (royal blue, 

blue, green and orange-red). This combination not only allows for optimisation of LED spectral output to the current 

regulations but also provides the capacity to adapt to possible future changes: for example, a decrease in the 10 µm 

lower limit of Division 2 to include the cyanobacteria. 

The fluorescence emission stimulated by light from the LEDs is detected within a waveband centred at 682 nm (deep 

red). This waveband is very closely matched to the variable fluorescence emission from functional photosystem II 

(PSII) complexes within phytoplankton, which provides the best indication of cell vitality. 

FastBallast employs a variant of the so-called Single Turnover (ST) method, which involves the application of 400 

microsecond pulses from the excitation LEDs to saturate photosynthesis. Most alternative systems use the Multiple 

Turnover (MT) method which applies pulses of several hundred milliseconds. The ST method is more difficult (and 

more expensive) to implement than MT-based methods. However, the thousand-fold decrease in pulse duration 

provided by ST allows for a dramatic increase in sampling rate. As a consequence, the signal to noise (S:N) ratio of ST-

based systems is orders of magnitude higher than MT-based systems. With FastBallast, this S:N ratio advantage is 

pushed further through optimisation of: 

• The optical configuration 

• The LED drive system 

• The measurement protocol 

• The algorithm used to analyse primary data 

The overall result is a level of sensitivity that allows for the detection of individual phytoplankton cells, even at the 

low end of the 10 – 50 µm size range. 

The sample chamber within FastBallast holds 20 mL of sample. The interrogated volume, from which the 

fluorescence emission is recorded at any point during a test, is 0.5 mL (2.5% of the total sample volume). Because the 

ST pulses applied by FastBallast are so short, it is possible to take reliable measurements as the incorporated stir unit 

continuously exchanges the interrogated volume. The ST measurement pulses are applied at 40 Hz throughout a test, 

with 40 consecutive pulses being averaged to generate a data point (an acquisition) every second. The stir speed is 

slow enough to provide a low level of exchange during each acquisition but fast enough to ensure that the entire 20 

mL volume is interrogated over the duration of the test. This setup: 

• Eliminates potential sampling errors at cell densities close to the PASS/FAIL threshold 

• Allows for a cell size-independent estimation of cell density using a proprietary data analysis algorithm  

A more detailed discussion of active chlorophyll fluorometry and the analysis methods embedded within FastBallast 

is provided within Background information. 
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2 Operation of the unit 

2.1 First steps 

If the battery within the FastBallast unit is completely discharged, it should be charged for at least 30 minutes before 

use. 

A 

Open the lid. 

 

B 

Pull out the stir unit. 

 

C 

Slide the stir unit collar 
from the storage 
position to the test 
position (all the way 
through the J grooves 
on the side of the 
unit). 

 

D 

Fill a measuring cup up 
to the bottom of the 
rim grooves with 
sample (20 mL). 

 

E 

Pour into the sample 
chamber. 

 

F 

Install the stir unit 
within the sample 
chamber and plug it 
into the Stirrer socket. 
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G 

Remove the Panasonic 
ToughPad from the lid, 
turn it on and log in. 

The ToughPad can be 
kept within the lid or 
hand-held while a test 
is running. 

 

 

H 

Turn the FastBallast on 
by pressing the power 
button on the top 
panel. Wait 10 s before 
starting FaBtest. The 
FastBallast should 
attach within half a 
minute. The Bluetooth 
connection is normally 
effective to at least 
10 m with a clear line 
of sight.  

I 

If the FastBallast doesn't 
attach to FaBtest, make 
sure that the power button 
is showing a blue light.  

If the blue light isn't 
showing, the FastBallast 
unit probably needs 
charging. 

If the blue light is showing, 
follow the instructions 
provided within Bluetooth 
problems. 

 

 

2.2 The test 

Depending on the sample, a test will run for under two minutes (level 1) or just over eight minutes (level 2).  

FaBtest will automatically turn the FastBallast off once a test has completed or if a test is halted by the user.  

• A level 1 test reports a PASS or a FAIL and an accompanying numeric 
o A PASS will always have a numeric of no more than 0.04  
o A FAIL will always have a numeric of at least 40 

• If the numeric is greater than 0.04 and less than 40 at the end of a level 1 test, FaBtest will jump straight into 
a level 2 test 

o The boundary between a level 2 PASS or FAIL is a numeric of 1.0 

The first test shown here is a blank test conducted using tap water (Tap water test). This is a good test to apply 

between ballast water samples as it ensures that there is no carry over of cells between tests. 

The second test is with a suspension of living phytoplankton cells (Live cells test). 
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Tap water test – A 
Initially, FaBtest will 
optimise the setup to 
generate a Range: value of 
30 – 100%.  

In the screenshot shown 
right, the range value has a 
yellow background because 
it is below 30%. 

A range value of more than 
100% is shown with a red 
background. 

 

 

Tap water test – B 

Following optimisation, 
FaBtest reports the current  
PASSING or FAILING status 
with a numeric. The run 
time and time until the end 
of the test are also shown. 

 

 

Tap water test – C 
Pressing the Show data 
button switches to the data 
window. 

 

Tap water test – D 

Pressing the Hide data 
button switches back to the 
main window. 
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Tap water test – E 
Pressing the Show settings 
button switches to the 
settings window.  

 

Tap water test – F 
 Pressing the Hide settings 
button switches back to the 
main window. 

 

Tap water test – G  

The test data are 
automatically archived 
within a timestamped file 
(14th December 2016 at 
15:05:52 in this instance). 
The sub-folder name  is the 
test date. A new sub folder 
is automatically generated 
each day that a test is run. 

 

 

Tap water test – H 
This timestamped file 
includes all primary data 
from the test. 

In this instance, the test 
result clearly indicates that 
the sample chamber and stir 
unit are not contaminated 
with living phytoplankton 
cells. 
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Live cells test – A 

Initially, FaBtest will 
optimise the setup. 

 

 

Live cells test – B 

For the first few points after 
optimisation, FaBtest will 
report an end time that is 
consistent with a level 1 test 
(one minute or less by 
default). 

 

Live cells test – C 

Once the number of points 
acquired passes 10, the end 
time may increase to reflect 
a level 2 test time. However, 
the switch to level 2 won't 
happen until at least 120 
points have been acquired. 
In this case, the level 1 test 
analysis is reporting a 
PASSING result with a 
numeric of 0.637. 
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Live cells test – D  

Pressing the Show settings 
button switches to the Test 
settings window. This only 
changes the right hand 
column. 

 

Live cells test – E  

Pressing the Hide settings 
button switches back to the 
main window. 

 

 

Live cells test – F 

Once the points count has 
reached 120, FaBtest will 
report at level 2. In this case, 
FaBtest has gone from a 
PASSING result at level 1 to a 
FAILING result at level 2.  

The difference between a 
level 1 and level 2 test is 
explained in detail within 
Interpretation of test data. 

 

 

Live cells test – G  

At completion of a level 2 
test, FaBtest reports a PASS 
or FAIL plus an estimate of 
cell density. In this case, the 
result is a FAIL with an 
estimate of 21.6 cells / mL 
(2.16 times the PASS/FAIL 
threshold for division 2 of 
the IMO / USCG standards). 
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2.3 After the test 

FaBtest will automatically turn the FastBallast unit off once a test has completed, to save battery life.  

To prepare for the next test: 

A 

Remove the stir unit and empty the sample 
chamber using a 30 mL syringe with cropped 1 
mL Pasteur pipette installed, as shown right. 

As an alternative to the syringe, a piece of 
kitchen towel can be used to soak up the 
sample. 

 

B 

Wash the sample chamber out with tap water at least twice, using the 30 mL syringe or kitchen towel to empty the 
chamber each time. 

C 

Dry the chamber out with a piece of kitchen towel. 

D 

Wash the stir unit with tap water and dry with a piece of kitchen towel. 

3 Routine checks 

3.1.1 Battery check 

The FastBallast unit includes a fuel gauge, which provides an estimate of battery charge remaining. The current 

battery status is reported by FaBtest… 

  

A 100% charge will provide at least 8 h operation. 

A full charge requires approximately 6 h, whether or not the unit is switched on. 

3.1.2 Consumables 

The 20 mL sample cups provide the correct volume for a sample. These can be washed and re-used many times. 

Kitchen towel is ideal for soaking up the sample once a test has completed. However, the provided syringe can also 

be used to empty the sample chamber (see step-by-step instructions). 

Tap water is ideal for flushing out the sample chamber between tests and running as a blank test. Suitable bottles are 

provided within the storage bag, for situations where tap water is not going to be available on-site. If these bottles 

are used, the tap water should be refreshed each day. 
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4 FaBtest 
FaBtest is a Windows desktop application for controlling FastBallast. A copy of FaBtest is installed on the Panasonic 

Toughpad supplied as part of the FastBallast system. Installation files for FaBtest are also included on the USB key 

supplied as part of the FastBallast system. FaBtest can be installed on most Windows computers running 32-bit or 64-

bit versions of Windows 10. 

System requirements for FaBtest are modest: it is extremely unlikely that any hardware capable of running Windows 

10 will not also run FaBtest. Attaching FastBallast to the hardware running FaBtest requires a free USB 2.0 port or 

Bluetooth capability. When run, FaBtest will search all available COM ports and attach to the first FastBallast found. 

The required COM port can be provided by the Bluetooth device incorporated within FastBallast or physical 

connection through the USB port. 

Most users will only ever use a very limited range of the functionality provided by FaBtest. Running a test will 

generally involve starting FaBtest, waiting a few seconds for the FastBallast to attach and then pressing the Run test 

button. FaBtest will optimise settings, run the most appropriate test (level 1 or level 2), report the result on screen 

and archive the test data within a timestamped file.  
In addition to the highly automated test procedures, FaBtest provides low level control of FastBallast, including 

instrument calibration. It also incorporates a number of functions for visualisation, processing, archiving and export 

of FaBtest data.  

4.1 The home screen, settings screen and data screen 

This section provides a basic introduction to the three screen views available in FaBtest. A more detailed description 

of the terminology used is provided within other sections of this handbook. 

4.1.1 Home screen 

 

The initial FaBtest home 
screen looks like this. The 
Ship:, Tank:, Run by: and 
Note: fields can be edited at 
any time by pressing the 
dashes after each label. 

Text entered within these 
fields is saved with the file. 
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If there is a FastBallast unit 
available (through Bluetooth 
or USB cable), FaBtest will 
automatically connect to it. 
The first time FaBtest 
connects to a FastBallast, 
connection may take as 
much as 30 s. Subsequent 
connections to the same 
unit will generally be much 
quicker. 

 

 

Pressing the Run test 
button starts a test. Over 
the first few seconds or tens 
of seconds, FaBtest will 
make adjustments to the 
settings to optimise the test 
setup. 

The End time field will 
initially show the time set 
for a level 1 test. 

 

 

In this example, the test 
initially shows a PASSING 
result. However, as noted 
elsewhere, this initial (level 
1) result is a simple function 
of the Activity parameter 
(variable fluorescence, Fv). 

The End time field has now 
shows the level 2 test time. 
This is because the 
PASS/FAIL numeric is 
between 0.04 and 40.0 (see 
The level 1 test for details). 
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Although the need for a 
level 2 test can be 
established within the first 
few seconds, FaBtest will 
continue to report at level 1 
until the Points count 
reaches 120. 

In this case, the switch to 
level 2 has changed the 
PASSING to a FAILING and 
the PASS/FAIL numeric has 
increased by a factor of 
almost three. 

 

 

At the end of the test, the  
FAILING (or PASSING) 
changes to a FAIL (or PASS). 
Because this test ran to level 
2, an estimate of cell density 
is also provided. The final 
Test length: of 08:18 s 
comprises 480 data points 
at 1 Hz plus 18 s  
optimisation time 
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4.1.2 Settings screen 

 

The settings screen can be 
reached by pressing the 

Show settings button on 
the home screen. Only the 
right of the screen changes, 
to show the Test settings. 

 

The Hide settings button 
on the settings screen 
reverts to the home screen. 

 

 

 

If a test has completed, the 
Test settings section shows 
the settings used 
throughout the test. The 
one setting that can change 
during the test is the PMT 
eht. The voltage shown is 
that used at the end of the 
test.  
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4.1.3 Data screen 

 

The data screen is only available 
when the file being viewed has 
ten or more data points 
(acquisitions). It can be 

accessed by pressing the Show 
data button on the main screen 
or settings screen. 

 

 

If Advanced → Data / Show 
more is selected from the 
menu, additional fluorescence 
parameters are shown on the 
data screen. 

A detailed description of all 
reported parameters can be 
found within Additional 
fluorescence parameters 
reported by FaBtest. 

 

 

Once the test has completed, 
an individual acquisition can be 
selected within the top panel. 
The lower panel shows the 
selected acquisition (black line) 
with a mean of all acquisitions 
within the test. 

See The level 2 test for details 
of how the Fv data within the 
top panel are analysed to 
generate an estimate of cell 
density. 
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4.2 Menus 

4.2.1 File menu 

 

The File menu incorporates the basic file options (New, Open…, Save and Save As…) plus a list of the most recently 

opened FaBtest data files. 

The Set the auto-save path… option allows the end user to change the default path for auto-save files. 

The Exit option closes FaBtest. 

4.2.2 Advanced menu 

 

The Revert to defaults option resets all data acquisition and data processing settings to the default values. This 

option can safely be used to troubleshoot the system during testing. 

All other functions within the Advanced section are provided for use by systems engineers and specialist users. None 

of these functions are required for running standard tests. 

4.2.2.1 Advanced → Data 

 

When the Show more option is checked, additional parameters are shown on the Home screen and Data screen.  

The Acquisition… option opens the Data acquisition dialog. 

The Processing… option opens the Data processing dialog. 

4.2.2.2 Advanced → Clipboard 

 

All four functions copy data to the Windows Clipboard in a format that can be pasted directly into a spreadsheet-

based application (such as Excel) or text editor (such as Notepad). 
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The Data summary option constructs a very detailed data set, including all settings and calibration values. 

The Trace data option formats the data points for all acquisitions within the file. 

4.2.2.3 Advanced → Engineering 

 

When the Log errors option is checked, FaBtest will write errors generated while communicating with the attached 

FastBallast unit to this logging file: 

c:\FaBtest\App\FaBtestErrors.csv.  

Similarly, when the Log battery status option is checked, FaBtest writes the battery status every five minutes to this 

logging file: 

c:\FaBtest\App\FaBtestBatt.csv.  

Both files can be opened by a number of applications, including Excel and Notepad. 

4.2.2.4 Advanced → Engineering → Calibration 

 

The Save to file option generates a backup of the calibration data stored within an attached FastBallast unit. A copy 

will already have been generated on the Toughpad supplied with the FastBallast unit as part of the factory 

calibration. This file can be found at the following location: 

c:\FaBtest\App\16-0550-001.fbc 

Where 16-0550-001 is the serial number of the FastBallast unit. An additional copy of the file can also be found on 

the USB key supplied with the system.  

4.2.2.5 Advanced → Engineering → Troubleshooting 

 

The Reload calibration… option can be used to reload calibration data from a file. The name of the calibration file is 

the same as the serial number of the FastBallast. During factory calibration, a copy of this file is generated at the 

following location: 

c:\FaBtest\App\16-0550-001.fbc 

A copy of this file can also be found on the USB key supplied with the FastBallast system.  

The Reset calibration option will wipe the existing calibration data within an attached FastBallast. It should only be 

used if the FastBallast becomes unstable or if the FastBallast is in the process of being re-calibrated. 
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4.2.3 Help menu 

 

About FaBtest… opens the About dialog to provide the installed FaBtest version number. 

4.3 Dialogs and functions 

4.3.1 Set the auto-save path 

This function can be accessed by selecting File / Set the auto-save path… from the menu. 

Data are automatically archived at the end of each test. The default location for these data is: 

Windows / Users / Public / FaBtest / Auto-saved FastBallast test data 

A new sub-folder is generated for each day that data are logged. For example, a test completed on 8th December 

2016 would result in the creation of a sub-folder named 20161208 (if this sub-folder didn't already exist). The 

automatically archived file is saved within this sub-folder. 

4.3.2 Revert to defaults 

This function can be accessed by selecting Advanced / Revert to defaults from the menu. 

The default data acquisition and data processing parameters generally provide optimum system performance. If any 

parameters have been changed, the defaults can be restored by selecting this function. This opens the following 

dialog… 

 

Press the Yes button to close the dialog and overwrite the existing data acquisition and data processing parameters 

with the default values. 

4.3.3 Show more parameters 

This function can be switched on and off by selecting Advanced / Data → Show more from the menu. It always 

defaults to off each time FaBtest is started. 

When checked, this function increases the number of fluorescence parameters presented on the home screen and 

data screen. Most of these addition parameters are only provided once a test has completed. This function has no 

effect on the format of data exported using the clipboard functions (described below). All of the additional 

parameters are only likely to be of interest to specialist users. 

4.3.4 The Data acquisition dialog 

Select Advanced → Settings → Data acquisition… from the menu. 
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This dialog allows the user to change the parameters used to define a test protocol. The above example shows the 

default values. When running standard tests, there is generally no reason to change any of these parameters.  

4.3.4.1 Test times 

Level 1 (s): The run time for a level 1 test 

Level 2 (s): The run time for a level 2 test 

Both the level 1 and level 2 test times are the actual data acquisition times and don't include the time required to 

change the PMT eht (auto gain) to keep the signal from the PMT within range of the data acquisition system. 

4.3.4.2 PMT eht 

Starting V: The voltage applied to the PMT at the start of a test. If the signal is out of range of the data acquisition 

system at the start of the test, FaBtest will adjust the voltage to bring it into range (increase the voltage if the signal 

from the PMT is too low and decrease the voltage if the signal from the PMT is too high). 

4.3.4.3 LED mA  

455 nm: The drive current applied to the royal blue LEDs (mA) 

470 nm: The drive current applied to the standard blue LEDs (mA) 

530 nm: The drive current applied to the green LEDs (mA) 

624 nm: The drive current applied to the orange-red LEDs (mA) 

The default values (280 mA for the royal blue and standard blue and zero current for the green and orange/red) have 

been selected to maximise the fluorescence signal from phytoplankton groups that incorporate chlorophyll b or c as 

the main accessory light-harvesting pigment and minimise the fluorescence signal from phytoplankton groups that 

don't incorporate chlorophyll b or c as the main accessory light-harvesting pigment. This is because most 

phytoplankton cells within the D2 size range (10 to 50 µm in the smallest dimension) do incorporate chlorophyll b or 

c as the main accessory light-harvesting pigment, while most phytoplankton cells that don't incorporate chlorophyll b 

or c as the main accessory light-harvesting pigment are below 10 µm in the smallest dimension and are, therefore, 

currently excluded from the D2 regulations.  

It should be noted that a wide range of phytoplankton species that do incorporate chlorophyll b or c as the main 

accessory light-harvesting pigment are below 10 µm in the smallest dimension and, consequently, these LED settings 

only provide an imperfect 'screen' of cell size. 

Although the green and orange/red channels are not currently used within the default test setup, they will be 

incorporated within future software updates (as the analysis algorithm is developed). They also effectively future-

proof FastBallast against the possible inclusion of cyanobacteria (which are below 10 µm in the smallest dimension 

and incorporate accessory light-harvesting pigments that are preferentially excited by green and/or orange-red light) 

within possible updates to the ballast water discharge regulations. 
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4.3.4.4 Saturation pulses 

Turn on (µs): The time interval between the start of data acquisition and the start of the LED pulse  

Turn off (µs): The time interval between the start of data acquisition and the end of the LED pulse 

Interval (ms): The time interval between the start of adjacent LED pulses 

Repetitions: The number of LED pulses applied during an acquisition 

Each data point within a test file is calculated through analysis of the mean of all LED pulse repetitions within an 

acquisition. In the above example, 40 LED pulses, each of 400 µs duration, are applied on a 25 ms pitch. 

Consequently, data points are generated at 1 Hz, with each acquisition being formed by averaging the data from the 

40 LED pulses. 

4.3.5 The Data processing dialog 

Select Advanced → Settings → Data processing… from the menu. 

 

The parameters set through this dialog are used in the processing of data during level 1 and level 2 tests. The default 

values have been derived through extensive testing and should only be changed under guidance from a CTG scientist. 

4.3.5.1 Fv per cell analysis 

Fo slope points: The maximum number of points used to estimate Fo 

Fm slope points: The number of points used to estimate Fm 

Q factor: A factor used to convert the mean Fv to the PASS/FAIL numeric during a level 1 test 

4.3.5.2 Distribution analysis 

The parameters within this section are used to analyse the distribution of Fv values within a level 2 test.  

4.3.6 Calibration values dialog 

Select Advanced → Engineering → Calibration → Edit data… from the menu. 
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All values within this dialog are loaded from a FastBallast system each time it is attached to FaBtest. There is generally 

no reason for the end user to change any of these values. 

If the OK button is pressed, the following question will appear: 

 

If the Yes button is pressed, the following question will appear: 

 

If the Yes button is pressed, the following message should appear: 

 

If any changes were made, they will have been written to the FastBallast and will be loaded into FaBtest each time it 

is attached. 
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4.3.6.1 SN 

SN: The serial number of the attached FastBallast unit 

The serial number should be entered without dashes. In the above example, the serial number will be shown as 16-

0550-001 on the FastBallast unit. 

4.3.6.2 PMT calibration 

These values are used to normalise the PMT output at the set PMT eht. 

4.3.6.3 LED calibration 

These values are used to normalise the output from all four LED channels.  

4.3.7 Save calibration values to file 

Select Advanced → Engineering → Calibration → Save to file… from the menu. 

The following message will appear: 

 

The file generated is saved at the following location: 

c:\FaBtest\App\ 

The name of the file is the serial number of the attached FastBallast plus an fbc extension. For example: 

16-0550-001.fcb 

A copy of this file is also provided on the USB key supplied as part of the FastBallast system. It can be used to re-

install the calibration data within FastBallast if the system becomes unstable (see Troubleshooting). 

4.3.8 Copy the calibration data to the clipboard 

Select Advanced → Engineering → Calibration → Copy to clipboard from the menu. 

The following message should appear: 

 

The calibration data can then be pasted into a spreadsheet-based application, such as Excel. 
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4.3.9 The About dialog 

Select Help → About from the menu. 

This dialog provides the FaBtest version number. 
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Technical section 
5 Troubleshooting 

5.1 Bluetooth and other connection problems 

5.1.1 Symptom: The FastBallast is turned on but FaBtest just shows FastBallast: Not 
attached 

5.1.1.1 Test A: Check that another copy of FaBtest is not running on the ToughPad and already attached to 

the FastBallast. The ToughPad screenshot below shows two copies of FaBtest running. One copy is 

already attached to the FastBallast, preventing the second copy from attaching.  

 

5.1.1.2 Test B: If there are multiple FastBallast systems on site, check that the S/N on the back of the 

ToughPad matches with the S/N inside the lid of the FastBallast. 

5.1.1.3 Test C: Turn the FastBallast and ToughPad off and on again. 

5.1.1.4 Test D: Use the included FastBallast to USB cable (2355-085-PL-A) as an alternative to the Bluetooth 

connection. The FastBallast should attach to FaBtest automatically. 

5.1.1.5  Test E: If FastBallast does attach to FaBtest when the USB cable is used (test D), check the 

Bluetooth connection: 
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• Go to Windows Settings / Devices / Bluetooth 

• The FastBallast unit should show up and be Paired or Connected, rather than Ready to pair 

 
• If you are unsure of which listed Bluetooth device is the FastBallast, turn the FastBallast off and see 

which device disappears from the list 

• If the FastBallast is Ready to pair, select and press Pair 

 
• You may need to re-start the ToughPad and/or the FastBallast for the connection to work 

5.2 The Menu Font is too small 

Go to Windows Settings / System / Display / Advanced display settings / Advanced sizing of text and other items 

It is recommended that the Title bars and Menus options are set to 12 point. 

6 FaBtest WARNING and other messages 

6.1 WARNING: Calibration data not read from FastBallast 

This may be a one-off event. Try closing FaBtest and restarting. If the message persists, you will need to restore the 

calibration data stored within FastBallast. 

7 Maintenance intervals 
The FastBallast system should be returned for a factory refit and calibration every two years. The refit includes: 

• Replacement of the internal rechargeable battery  

• Replacement of all O-ring seals 

• Testing of internal electronics  

• Instrument re-calibration  

• Reset and updating of the Panasonic Toughpad 
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Background information 
8 Constant and variable fluorescence from phytoplankton 

8.1 Phytoplankton fluorescence 

Phytoplankton contain membrane-bound protein complexes called photosystems which are able to perform 

photochemistry (absorb and convert light energy into chemical energy, which can then be used for cell growth and 

maintenance). A small proportion of the light absorbed by the photosystems within viable phytoplankton cells is re-

emitted as chlorophyll fluorescence, which can be detected by active chlorophyll fluorometers, such as FastBallast. A 

significant complication is that the fluorescence signal from ballast water may include contributions from other 

sources, including dead phytoplankton cells, free chlorophyll and CDOM (coloured, dissolved organic matter). 

Consequently, the total fluorescence signal detected by FastBallast (or any other active fluorometer) is not a reliable 

metric for reporting the concentration of viable phytoplankton cells. 

There are actually two types of photosystems within phytoplankton: Photosystem II (PSII) and Photosystem I (PSI) – 

see Figure 1. Although fluorescence is emitted from chlorophyll a within both PSII and PSI, PSII differs from PSI (and 

all other contributors to the fluorescence signal detected by FastBallast) in emitting both constant fluorescence and 

variable fluorescence. All other sources only emit constant fluorescence.  

 

Figure 1: Schematic representation of the protein complexes and cofactors involved in oxygenic photosynthesis. This 

particular schematic incorporates light harvesting systems (LHCII and LHCI) that are typical of higher plants and green 

algae. Other phytoplankton groups differ in the structure of their light harvesting systems but are otherwise 

consistent with this schematic. Taken from Govindjee et al. 2010. 

All active chlorophyll fluorometers have the ability to isolate the variable fluorescence originating from PSII 

complexes (Fv) from the constant fluorescence originating from all other sources. Importantly, Fv is only emitted by 

PSII complexes that are photochemically active: PSII complexes that are damaged during ballast water treatment lose 

the variable component of their fluorescence emission and only contribute to constant fluorescence. 

8.2 Measurement of Fv 

There are two well established methods for the measurement of Fv: the single turnover (ST) method and the multiple 
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turnover (MT) method. Both ST and MT-based systems generate Fv by applying a short pulse of light to the sample. 

This pulse is bright enough to saturate photochemistry within a very high proportion of the active PSII complexes 

within the sample. As PSII photochemistry approaches complete saturation, the yield of fluorescence from these 

complexes increases from Fo to a maximum level (Fm). Fv is simply the difference between Fo and Fm (see Figure 2). It 

is important to emphasise that, although the measured Fo is likely to include a significant contribution from sources 

other than active PSII complexes, the measured Fm will include exactly the same contribution from these sources. 

Consequently, the calculated value of Fv (Fm – Fo) is independent of all sources of constant fluorescence. 

Within ST-based systems, the saturation pulse is bright enough to saturate PSII photochemistry within 100 to 400 µs. 

The minimum interval between successive photochemical events within a PSII complex is (on average) about 600 µs. 

Consequently, only a very small proportion of PSII complexes undergo more than one photochemical event (a single 

turnover) during each saturation pulse. The impact of a saturating ST pulse is normally dissipated within 25 ms. 

Consequently, measurements from a static sample can be taken at a frequency of up to 40 Hz. 

 

Figure 2: A sample data 
trace from FastBallast. 
The trace is an average of 
40 ST pulses acquired at 
40 Hz, each of 400 points 
acquired at 1 MHz. The 
trace therefore 
represents an acquisition 
formed from all data 
collected over 1 s. 
Additional details are 
provided within the main 
text. 

The LED output during a FastBallast ST pulse is usually between four and eight times full sunlight, depending on the 

sample. This is about five times as bright as a MT saturation pulse. However, a MT pulse is up to 1000 times longer 

than a ST pulse. It follows that a single MT pulse delivers about 200 times as many photons as a single ST pulse. This 

is because the MT-method relies on multiple photochemical events (multiple turnovers) at each active PSII complex 

within the sample being induced during each saturation pulse. An inevitable consequence of the multiple turnovers 

is that a very long time interval (tens of seconds) is required to dissipate the impact of each saturation pulse.  

Parameter Single turnover Multiple turnover 

Duration of measurement pulse 400 µs 40 – 1200 ms 

Recovery time between successive pulses 25 ms 10 – 100 s 

Maximum measurement frequency with a static sample 40 Hz 0.1 Hz 

Maximum linear flow rate (10% sample exchange) 2 m s-1 < 0.01 m s-1 

Table 1: Summary of performance differences between single turnover (ST) and multiple turnover (MT) systems. 
The low maximum linear flow rate imposed by the MT method effectively rules out MT measurements being made 

on a moving sample. In addition, the very long interval required between MT saturation pulses severely limits the 

signal to noise ratio (S:N) and, ultimately, the detection limit of MT-based systems. 
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The fluorescence traces within Figure 3 provide a graphic illustration of the main differences between ST and MT 

measurements. Both traces were generated from the same suspension of cultured cells of Chlorella sp. A FastOcean 

Fast Repetition Rate fluorometer (FRRf) was used to collect these examples as this type of sensor can easily be 

programmed to generate alternate ST and MT measurements.  

The red bar within the MT panel of Figure 3 provides a graphic illustration of the time difference between ST and MT 

pulses. The difference in measurement frequency is almost as dramatic: whereas a pulse interval of 100 ms is more 

than sufficient for ST measurements, at least 30 s is required between successive MT pulses. 

The amplitudes of Fv generated during the ST and MT measurements are shown within Figure 3. Also included are 

values for Fv/Fm. This parameter is widely used, outside the field of ballast water discharge testing, as an indicator of 

photosynthetic efficiency within phytoplankton cells. Typically, ST values for Fv/Fm are 15 – 20% lower than MT 

values, within healthy cultures under nutrient replete conditions (as is the case here). The extent of this difference is 

well documented (e.g. Kolber et al. 1998) and is consistent across a wide range of phytoplankton species. Within the 

example shown in Figure 3, it is clear that the lower value of Fv/Fm from the ST measurement is due to a lower value 

for Fv (the amplitude of the fluorescence increase induced by the pulse). Again, this difference is well documented 

and consistent among phytoplankton species. 

 

Figure 3: Data collected 
from a single sample of 
Chlorella sp., using a 
FastOcean sensor, to 
illustrate some the 
differences between the 
ST method employed 
within FastBallast and the 
more commonly used MT 
method. 

8.3 Fv and cell viability 

Phytoplankton cell viability is closely linked to their capacity for PSII photochemistry. A robust quantitative 

relationship between the fluorescence emitted by active PSII complexes and the capacity for photochemistry, within 

a wide range of phytoplankton species, has been demonstrated by Oxborough et al. (2012) and Silsbe et al. (2015). 

The data presented within these studies indicate that the constant component of the fluorescence emission arising 

from active PSII complexes (Fo) is better correlated with the capacity for photochemistry than Fv, when working with 

healthy phytoplankton cultures under nutrient-replete conditions. However, it has always been clear that the 

relationship between Fo and the capacity for photochemistry breaks down in situations where constant fluorescence 

from sources other than active PSII complexes becomes significant.  

In contrast to Fo, Fv is unaffected by additional sources of constant fluorescence. Consequently, there are some 

situations where it is better to work with the relatively low variability between Fv and the capacity for 

photochemistry than to ignore the potentially much larger errors introduced by the contribution of constant 

fluorescence from sources other than active PSII complexes. This is certainly the case with ballast water discharge, 

where such contributions can be extremely high. 

The FastBallast data presented within Figure 4 illustrate the impact of constant fluorescence from sources other than 

active PSII complexes. Both traces are from cultured cells of the marine chlorophyte, Dunaliella tertiolecta. The 

difference is that the sample on the left was prepared by diluting the culture with a cold tea infusion (which contains 

significant levels of CDOM and some free chlorophyll a) prepared with F/2 medium (artificial sea water) while the 

sample on the right was prepared by diluting the culture with F/2 medium alone.  
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One very obvious feature of these data is that diluting with the tea infusion has added a high background signal. 

Because this background fluorescence contributes to the measured values of Fo and Fm, but not to the calculated 

value of Fv, the calculated value of Fv/Fm is much lower (less than 4% of the value from the sample diluted with 

artificial sea water).  

If an Fv/Fm this low was recorded from a pure (single species) cell culture that had been subjected to stress, it might 

reasonably be concluded that the culture was unlikely to recover, even if the source of stress was removed. However, 

ballast water discharge could be very different from a pure cell culture and a more cautious approach to the 

interpretation of low Fv/Fm values is required. This is because, as already discussed, the constant component of the 

fluorescence recorded by FastBallast can include a significant contribution from non-viable phytoplankton cells,  

including species with low tolerance of ballast water treatment and/or the environment within ballast water tanks, in 

addition to free chlorophyll and CDOM. It follows that the total contribution from these sources could generate a low 

measured Fv/Fm even if the sample also contains a significant number of viable phytoplankton cells (i.e. cells that 

have a high tolerance of ballast water treatment and the environment within ballast water tanks). 

 
Figure 4: Sample test data from FastBallast. The top panels show traces from a suspension of cultured cells of 

Dunaliella tertiolecta. The bottom panels show detail from the top panels. The cell suspension used to generate the 

left trace was prepared by diluting a more concentrated culture, using a tea infusion prepared with F/2 medium. The 

cells suspension used to generate the right trace was prepare by diluting cells with F/2 medium alone. Both traces 

are the mean of 16 sequences acquired at 0.1 Hz. Further details are provided within the main text. 

8.4 Fv per cell 

The accuracy of any estimate of cell density based purely on Fv clearly depends on the variability of Fv generated by 

phytoplankton cells. Table 1 provides data from our own programme of testing. Measurements of Fv at known cell 

densities were made using calibrated FastOcean and FastBallast systems. Cell volumes were determined through 

microscope-based measurements. The number of PSII complexes per cell was estimated using a flash-O2 system, 

incorporating an Act2 control unit and Hansatech Oxygraph system. A similar combination was used by both 
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Oxborough et al. (2012) and Silsbe et al. (2015). 

Within the list of species used, there is one coccolithophore (Emiliania huxleyi), four diatoms (Phaeodactylum 

tricornutum, Thalassiosira pseudonana, Thalassiosira weissflogii and Thalassiosira punctigera) and three 

chlorophytes (Chlorella vulgaris, Dunaliella tertiolecta and Dunaliella salina). This range of species incorporates a 

number of cell shapes plus wide ranges of cell volume (four orders of magnitude), Fv per cell (two orders of 

magnitude) and PSII complexes per cell (two orders of magnitude).  

Species Shape 
Smallest 
dimension 
(µm) 

Volume (µm3) Fv per cell 
PSII 
complexes 
per cell 

Emiliania huxleyi Spherical 4 – 5 30 – 55 0.00022 9.11 x 105 

Chlorella vulgaris Spherical 2 – 3 7 – 15 0.000032 6.53 x 104 

Phaeodactylum tricornutum 
Fusiform – 
Triradiate and 
Ovoid 

2 – 3 60 – 150 0.00019 1.25 x 106 

Dunaliella tertiolecta Ellipsoid 8 – 12 480 – 1350 0.00022 9.69 x 105 

Dunaliella salina Ellipsoid 10 – 14 690 – 1500 0.00018 6.45 x 105 

Thalassiosira weissflogii Cylindrical 16 – 18 880 – 5500 0.00075 2.11 x 106 

Thalassiosira pseudonana Cylinder 7 – 8 200 – 300 0.0003 1.55 x 106 

Thalassiosira punctigera Capsule 30 – 55 63500 – 240000 0.016 5.58 x 107 

Table 2: Summary of data from our in-house PASS/FAIL boundary study. All values are based on a minimum 
of three independent measurements. All values are based on at least ten independent measurements. 
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8.5 The level 1 test 

From the data within Table 1, it is clear that the extreme variability of Fv per cell prevents accurate estimation of cell 

density based on an assumed Fv per cell, there are situations where the Fv measured from a ballast water discharge 

sample is so low or so high that a PASS or FAIL, respectively, becomes inevitable. In these situations, the level 1 

analysis applied by FaBtest can provide a result in under two minutes. 

The level 1 test applied by FaBtest generates a numeric that is normalised to the fluorescence signal generated by 1 

mg chlorophyll a dissolved in 1 m3 of 90% acetone when excited by the 455 nm LED waveband. 

Figure 5 uses the data provided from Table 1 to place all eight species on the level 1 numeric scale. What this plot 

shows is that all but one of the tested species fall within an order of magnitude of the PASS/FAIL boundary on the 

PASS side. However, the one species on the FAIL side (Thalassiosira punctigera) is more than an order of magnitude 

away from the PASS/FAIL boundary, with a level 1 numeric of 15.8. Consequently, even for the narrow range of 

species incorporated within this study, the total range of Fv per cell values covers two orders of magnitude. 

Based purely on the data presented within Figure 5, a PASS could perhaps be considered reasonable where the level 

1 numeric is below 0.1 and a FAIL where the level 1 numeric is above 20. The actual values applied by FaBtest are 

more conservative: a PASS is only reported where the level 1 numeric is below 0.04 and a FAIL where the level is 

greater than 40. To put these thresholds in perspective, even one healthy cell / mL of D. salina would generate more 

than four times the low numeric of 0.04 and approximately 25 healthy cells / mL of T. punctigera would be required 

to exceed the high numeric of 4.0. 

 

Figure 5: Summary of 
data from our in-house 
PASS/FAIL threshold 
study. All values are 
based on a minimum 
of ten independent 
measurements. 

Please note that the Fv 
values on the x-axis are 
on a log10 scale and are 
for 10 cells / mL. 

The numbers in 
brackets against each 
species are the level 1 
numerics generated at 
10 cells / mL. 
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8.6 The level 2 test 

The sensitivity of FastBallast is such that Fv can be measured accurately from a 0.5 mL sample containing a single 

phytoplankton cell (even at the low Fv per cell levels of C. vulgaris and D. salina). In principle, this level of sensitivity 

allows for interrogation of the Poisson distribution of cells at low density within ballast water. This type of analysis 

has a major advantage over the level 1 test because the estimate of cell density is derived from the distribution of Fv 

values within a series of discrete measurements, rather than the amplitude of Fv from a single measurement. 

At the simplest level, a Poisson-based test could involve a single measurements being made from a number of low 

volume sub-samples, taken from a larger well-mixed volume of ballast water. The data presented within Figure 6 

show the anticipated Poisson distribution of cell densities within 0.5 mL sub-samples, at different overall cell 

densities within the larger volume. An important feature of these distributions is that the spread of values, relative to 

the mean value, becomes narrower with increasing cell density. 

 

Figure 6: The interrogated volume 
within the FastBallast sample 
chamber is 0.5 mL. These plots show 
the expected Poisson distribution of 
cell counts within a large number of 
discrete 0.5 mL samples taken from 
a larger volume of ballast water 
containing 10, 20, 50 or 100 cells / 
mL.  

The legend shows mean cells / 0.5 
mL sample. The connecting lines are 
there to guide the eye. 

 

 

The test method that is actually implemented by FaBtest is a variation on this approach. Instead of taking 

measurements of Fv from a series of discrete samples, Fv data are acquired at 1 Hz by analysing an average of 40 ST 

sequences collected at 40 Hz. A full level 2 test acquires 1 Hz data for eight minutes, generating an Fv data set of 480 

points. The interrogated volume of 0.5 mL represents 2.5% of the 20 mL bulk sample volume. The sample is stirred at 

a speed that provides an optimum rate of sample exchange within the interrogated volume: slow enough to provide 

minimal exchange during each 1 s acquisition but fast enough to ensure that the entire sample is interrogated over 

the eight minute test period. 

Because the interrogated volume is continuous with the total sample volume, it allows for fractions of cells. From 

basic theory, it follows that the level 2 Fv data set should fit to the approximation of a Poisson distribution generated 

by a normal distribution with a standard deviation (SD) equal to the square root of the mean (√𝜎). The algorithm 

used to process level 2 data was actually derived using a mathematical simulation that incorporates this assumption. 

The data presented within Figure 7 illustrate how effective the real-time, non-iterative data processing algorithm 

embedded within FaBtest is in estimating cell density from the simulated data.  
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Figure 7: The x-axis values are the means of 64 test simulations, each of 480 Fv values. The y-axis values are means 
generated from the same 64 x 480 Fv values using the real-time data processing algorithm embedded within FaBtest. 
SD values for the FaBtest estimates are below 1 cell / mL up to 10 cells / mL and below 10% of the mean above 10 
cells / mL. 

The Fv distribution data presented within Figure 8 provide comparisons between actual test data (using cultured cells 
of the chlorophyte, Dunaliella salina) and simulations of the same nominal cell densities (27  and 126 cells / mL). 

 

 

Figure 8: Sample curves providing comparisons of the distribution of Fv data (blue lines) from FastBallast tests 
using cultured cells of the chlorophyte, Dunaliella salina and simulations of the same nominal mean cell densities 
(27 and 126 cells / mL). The orange curves show normal distributions generated by making the SD equal to the 

square root of the mean (√𝜎). Both curves extend to ±3 x SD. Points that fall outside this range are included within 
the first and last data values. 

 

The data presented in Figure 9 show estimates of cell densities derived from microscope-based cell counts (x-axis) 

against level 1 and level 2 test data. The species included within these plots are highlighted in green in Table 1. The 

solid purple lines define the 1:1 relationship between microscope-based estimates of cell density and level 1 or level 

2 test results. 
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The red-filled circles within Figure 9 use the default threshold value for the PASS/FAIL boundary (see Figure 5). This 

has generated a number of level 1 false positive results, which are all derived from tests on pure cultures of T. 

punctigera. This data set also includes a number of level 1 test false negatives, generated by the species with lowest 

Fv per cell values.  The green-filled circles use a level 1 threshold value that is 15.8 times the default. This makes it 

equal to the level 1 numeric generated by T. punctigera (see Figure 5). As a result, the false positives generated by T. 

punctigera at the default threshold value now lie within the green zone (i.e. are correctly reported as PASS values). 

However, the 15.8 times increase in the PASS/FAIL threshold has, inevitably, pushed samples with low Fv / cell even 

further into the false negatives zone, to the point where some samples with several hundred cells / mL are reported 

as a PASS. 

One thing that is clear from the data within Figure 9 is that the level 2 data points (open squares) are generally much 

closer to the 1:1 line than the level 1 data points (green or red filled circles). The only exceptions to this rule are the 

red level 1 points associated with T. weissflogii and the green level 1 points associated with T. punctigera, which are 

all very close to the 1:1 line. As noted above, the default PASS/FAIL threshold for the red points is very close to the Fv 

/ cell of T. weissflogii while the PASS/FAIL threshold for the green level 1 data points was specifically optimised for T. 

punctigera. Consequently, the fact that these points are so close to the 1:1 line is expected and simply demonstrates 

the consistency of FastBallast measurements. 

 

Figure 9: Circles represent level 1 data, squares represent level 2 data. The red-filled circles use the default level 1 
threshold value for the PASS/FAIL boundary (see Figure 5). The green-filled circles use a threshold value that is 15.8 
times the default value (equal to the level 1 numeric generated by T. punctigera). The only difference between A and 
B is the data range on the axes. Points within the green or red zones indicate a match between the microscope-based 
estimate and the level 1 or level 2 test result (green for a PASS and red for a FAIL). The grey zones within indicate false 
positives (against the y-axes) or false negatives (against the x-axes). Additional details are provided within the main 
text. 
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8.7 Test details 

The sample data presented within this section are all from a dilution series of healthy, cultured cells of Dunaliella 

tertiolecta. Each step dilution was approximately one in four. All of the screenshots presented within section have 

been taken with the Advanced → Data → Show more menu option activated.  

8.7.1 Test A 

The series starts at a high enough cell density to generate a level 1 test numeric of more than 40 (106.7). At this level, 

the test is halted once the set number of points for a level 1 test (default of 60) has been reached. Because there can 

be an order of magnitude difference between the PASS/FAIL numeric generated by a level 1 test and the density of 

cells within the sample, an estimate of cell density is not provided for this test (see The level 1 test for a discussion). 

 

8.7.2 Test B 

The first dilution generated a level 1 numeric of 26.3 (roughly 25% of the previous test). Because this is below the 

value of 40 required to stop the test at level 1, the test automatically ran straight into level 2. The test numeric from 

the level 2 is actually higher than test numeric for Test A, even though the Test B sample is a one in four dilution from 

the Test A sample. This result is very much in line with expectations because the Fv emitted by each cell of D. 

tertiolecta is 0.22 times the level 1 normalised value (see Table 2 and Figure 5).  

 

The Fv values within the top panel of the data screen for Test B show a significant increase over the first 200 points or 

so. This is likely to be due to a combination of dark adaptation and the cells adapting to a slight increase in 

temperature within the sample chamber. FaBtest corrects for such changes in amplitude over time by generating 

regression lines through the data set and building the Fv distribution as deviations from these lines, rather than 

deviations from the overall mean Fv value for the test (which would tend to underestimate cell density). A new 

regression line is started every 120 points. Consequently, the default level 2 data set incorporates four regression 

lines. 
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8.7.3 Tests C, D, E, F and G 

The decrease in test numeric for the subsequent dilutions is always consistent with the approximate one in four 

dilution at each step. One point to note is that the Fv/Fm value starts to decrease significantly after Test C – to below 

0.1 by Test G. This decrease can largely be attributed to the optical filtering within FastBallast. The filters located in 

front of the LEDs used to excite chlorophyll fluorescence and the PMT used to detect chlorophyll fluorescence have 

been selected to maximise the proportion of Fv detected. As a result, a very small proportion of the excitation LED 

light breaks through the filters and reaches the PMT. In this case, the proportion of the signal generated by this LED 

breakthrough is roughly equivalent to the Fo signal generated by five cells of D. tertiolecta. It is important to 

understand that this does not impact on the test results, simply because both the level 1 and level 2 tests only use 

the values of Fv, which are unaffected by LED breakthrough.  
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The data from Tests B to G are summarised within Figure 10. Test A is excluded because there is no level 2 result from 

this test. 

 

Figure 10: Estimates of cell density derived from Fv and known Fv per cell values and the level 2 distribution analysis. 

All values are from the primary data from a dilution series of healthy, cultured cells of D. tertiolecta, presented within 

the above screenshots (Test B to Test G). A shows values from Tests B to G, B shows values from Tests D to G. 
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Technical information 
9 Instrument calibration 
During a test, chlorophyll fluorescence from phytoplankton is excited by some combination the four LED wavebands 

within FastBallast and detected by a photomultiplier tube (PMT). A short pass filter located between the LED arrays 

and sample, in combination with a bandpass filter located between the sample and PMT, minimises filter 

breakthrough (light from the LEDs reaching the detection window of the PMT). 

Instrument calibration comprises: 

1. Standardisation of the output from the PMT over a range of gain settings 
2. Measurement of the output from each LED waveband over a range of drive currents 
3. Normalisation of all four LED wavebands 

The PMT calibration allows the potential between   

9.1 PMT calibration 

The FastBallast PMT is calibrated using four concentrations of a fluorophore called Basic Blue 3 (BB3) dissolved in 

MilliQ water. As shown below, the absorption spectrum of BB3 is relatively flat over the emission spectra of the 455 

nm and 470 nm waveband LEDs. The PMT calibration only used the 455 nm LED waveband to excite BB3 

fluorescence. The emission spectrum of BB3 overlaps very strongly with the transmission spectrum of the bandpass 

filter in front of the PMT, providing an easily detectable fluorescence signal. 

For historical reasons, the four concentrations of BB3 are selected to provide the same fluorescence signal as 

chlorophyll a dissolved in 90% acetone to final concentrations of 0.05, 0.4, 1.0 and 2.0 mg m-3 when fluorescence is 

excited by the 455 nm waveband with FastBallast. Two parameters are derived from the PMT calibration, which 

quantify the change in PMT sensitivity with eht (V) and the signal slope at the reference PMT eht (560 V). These 

values are stored within FastBallast and are used to normalise the fluorescence signal in real time. This approach 

allows for the PMT eht to be changed at any point during a test. An auto-PMT function is integrated within FaBtest to 

optimise the PMT eht throughout the test. Out of range data and data acquired during auto-optimisation of the PMT 

eht are automatically rejected. 

9.2 LED calibration 

As with the PMT calibration procedure, the LED calibration procedure uses BB3 dissolved in MilliQ water to generate 

a fluorescence signal that can be detected by the PMT.  

The LED output is recorded at each of five drive currents for each of the four LED wavebands. During real time data 

processing, an additional bias parameter, derived from one-off measurements from a range of phytoplankton 

cultures,  is used to normalise LED channels against each other. The LED outputs at each drive current and the bias 

parameters are stored within FastBallast. 
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Absorption spectrum of Basic 
Blue 3 dissolved in MilliQ 
water plus the emission 
spectra for the four LED 
wavebands within FastBallast. 

 

Emission spectrum of Basic 
Blue 3 dissolved in MilliQ 
water plus the transmission 
spectrum for the 682 nm 
bandpass filter located in front 
of the PMT in FastBallast. 
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Glossary 
 

Term Definition 

Active fluorescence 
The increase in the normalised fluorescence signal that is induced by a saturating pulse 
(see Fv).  

Activity Shorthand for Active fluorescence (Fv). 

ADC 
Analog to Digital Convertor. The value presented within FaBtest is percent of full scale. 

FaBtest automatically adjusts the eht voltage on the PMT to keep this value optimised. 

Baseline fluorescence Fluorescence signal arising from sources other than active PSII complexes. 

Fo 
The 'origin' of variable fluorescence (Fv). Fo can include fluorescence from sources other 
than photochemically active PSII complexes. 

Fm 
The 'maximum' fluorescence, assessed as the asymptote of the fluorescence signal 
induced by a saturating pulse. 

Fv 

Variable (active) fluorescence, calculated as Fm – Fo 

Active fluorescence (Fv) originates from photochemically active (functional) PSII 
complexes. Photochemistry provides the energy required for cell growth and 
maintenance. 

Fv/Fm 
The proportion of the total fluorescence signal that is active. In the absence of Baseline 
fluorescence, this parameter provides an estimate of PSII photochemical efficiency. 

Offset A mathematical offset applied to the reported Activity (Fv). 

PMT 
Photo-multiplier tube. This is the highly sensitive device used within FastBallast to detect 
the fluorescence signal. 

PSII Photosystem II. Active fluorescence (Fv) originates from PSII complexes. 

RSigma 
RSigma provides the rate at which the fluorescence signal increases between Fo and Fm 
during each measurement pulse. 

Saturating pulse 
A short, bright pulse of light applied to a ballast water sample. This pulse increases the 
fluorescence signal from Fo to Fm by transiently saturating PSII photochemistry. The 
saturating pulse applied by FastBallast is 400 µs duration at several times full sunlight. 
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Spares and replacement parts 
 

From Panasonic: 

http://panasonic.net/avc/pc/ 
 
Item Part number 

Panasonic Lithium Ion 2 Cell Battery Pack FZ-VZSU94W 

Panasonic 4-Bay Battery Charger FZ-VCBM11U 

 

From CTG Ltd: 

http://www.chelsea.co.uk/ 

sales@chelsea.co.uk 
 
Item Part number 

FastBallast stir unit 2355-138-PL-A 

Panasonic ToughPad with FaBtest installed 2355-149-PL-A 

FastBallast charger with 15 V at 1.2 A output 2355-137-PL-A 

FastBallast to USB cable 2355-085-PL-A 

FastBallast Ethernet cable 2355-086-PL-A 
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